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Thank you for purchasing PhotoLaser Plus!  

Epilog has teamed up with CadLink to bring you the exciting PhotoLaser Plus software package. Included in this 

document are: 

1) Instructions for transforming photographs in preparation for laser engraving 

2) Instructions on how to create a multiple badge layout using variable text.  

We will refer to many different aspects of this software, but the primary purpose of PhotoLaser Plus software 

is to TRANSFORM a photo from this:  

                       to this:   

     Original Photo       Transformed Photo 

Because this software is not a full version of the CadLink EngraveLab software we have compiled the 

information below to help you get started: 

 

1) The primary purpose of PhotoLaser Plus software is to provide a very easy method of transforming 
photographs for laser engraving. There are additional features included with the software, but the 
photo transform feature and the badge creation feature are currently the only features supported by 
Epilog at this time. For technical support on the software, please contact EngraveLab directly at 1-800-
545-9581.  
 

2) This PhotoLaser Plus software is not intended to replace your other graphic layout software such as 
CorelDraw or Adobe Illustrator. However, it is an ideal software package for transforming photos and 
provides a perfect complement to your other software. 
 

3) This limited version of PhotoLaser Plus does not qualify for an hour of free training CadLink offers with 
their “Full” versions of software. Epilog provides some short tutorials for preparing and transforming 
photographs, but additional training beyond our tutorials is not provided. 
 

4) As time permits, Epilog will provide additional training tutorials for two of the other exciting features 
included with this software – Serialization and Badge Layout. Please access the www.epiloglaser.com 
Technical Library to look for updates. 
 

5) In order to use PhotoLaser Plus you must be able to connect the computer it is installed on to the 
Internet in order to activate the software. The internet is the only means of activation. 
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Installing EngraveLab PhotoLaser Plus 

 

Follow standard installation protocol for installing PhotoLaser Plus onto your computer. 

 

During the installation process the Quick Start Guide 

for PhotoLaser Plus instructs you to choose a color 

palette to use with your laser.  

 

Unlike other lasers, you can use any color palette with 

your Epilog system and you can skip this step. Click on 

Cancel to move to the next screen.  

 

 

 

EngraveLab PLP initially installs as a demo version. In order to transform a photo, you must activate your product by 

connecting your PC that the software is installed on to the Internet. The demo version does not include all features 

necessary to transform a photo.  

 

An Activation Pin was included with your purchase of PhotoLaser Plus. Until you activate your software the following 

screen will be presented to you each time you open PhotoLaser Plus:  

 

 

 

To activate and register PhotoLaser Plus DL, select Yes. To continue running the product in Demo mode, select No. Note 

that during the operation of the Demo, you can also access the Registration page by clicking on the Help menu and then 

Register.  

 

If you select Yes or click on the Help menu and then Register, the following web page will display.  
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Fill out the Registration page including the Software Activation PIN number that was included when you received your 

software. After filling out the Registration page, click on the Submit button.  The following window will display.  

 

 

 

Click on OK and PhotoLaser Plus DL will close. The next time you run PhotoLaser Plus DL, the demo announcement 

screen will not appear. As well, you will no longer require an internet connection in order to operate the software.  
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After installing PhotoLaser Plus, go to www.epiloglaser.com/photolaserplus_training.htm: 

 

 There were Epilog specific Material Setting files that were loaded with your software, but there may be more 
up- to-date files available on our web site. These are .plr files and will need to be saved to your hard drive. These 
files provide custom material settings that Epilog has created specifically for various materials such as wood, 
acrylic, etc. The settings have been optimized so that your transformed photographs will look as good as 
possible when engraved with your Epilog laser. 
 

 Save the files to C:/Program Files/EngraveLab PhotoLaser Plus/photolaser. There should be other .plr files in this 
folder. If you can’t find the folder, search for .plr files and add these Epilog files to that folder. 
 

We’re now ready to set up a job and prepare a photograph. 

 

There are two common approaches to preparing, transforming and printing 

photographs: 

1) Preparing, transforming and printing photographs directly from PLP 

2) Preparing a photo in Corel, transforming in PLP and then printing from Corel. 

These two methods are provided because many of our customers are very familiar 

with Corel and will find it easier to print from Corel until they familiarize 

themselves with PLP. 

Preparing, transforming, and printing a photo from PLP starts on the next page. 

Preparing a photo in Corel, transforming in PLP and then printing from Corel 

follows the PLP instructions. 

*NOTE – When we talk about preparing a photo, we are talking about sizing, 

cropping, or any other function related to getting the photo ready prior to 

transformation. 
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Preparing, Transforming & Printing Photographs Directly From PLP 

 

 

Open PLP and Set Your Page Size 

 

When you open Photo Laser Plus, you’ll set your plate size. You 

have two choices:  size of the piece or entire table size. You’ll see 

many of the Epilog Laser system table sizes are preset to the 

engraving table size.  

 

You can also change your page size later if you wish. 

 

 

 

 

 

You can also click the Advanced button to set up more customized sizes for frequently run projects.  

 

 

 



Page 6 of 24 
 

Add Guidelines 

 

To make photo layout easier, add guidelines around the 

edges of the page.  

 

Right click with your mouse anywhere on the page to 

open the Edit Guides tool. 

 

Press the horizontal or vertical button to add a guideline 

and drag it to the edge of the page. 

 

Import your Image 

 

Select File/Import to import your image. 

 

 

 

 

 

Change Image Appearance 

 

If the file looks bitmapped when you import it, uncheck the “Show Reduced 

Bitmaps” option under the View menu.  

 

 

 

 

 

 



Page 7 of 24 
 

Crop The Photo 

 

To crop a photo, double click on the photo 

to open the bitmap tools at the top of the 

page. 

 

Select the Rectangle or Ellipse tool to frame 

the area you want to crop. 

With the area framed, use the Crop tool to 

finalize the crop.  

 

 

 

 

 

 

Resize the Photo 

After you’ve cropped the photo you 

may need to resize it to fit your 

available space. 

You can type in the exact X and Y 

dimensions, or you can use the sizing 

handles. 
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Set the Resolution (This step is vitally important!) 

 

It’s imperative that you set the resolution of 

your photograph to match the resolution you 

are going to use for printing.  If you have a 

mismatch between the photo resolution and 

the printing resolution your results are not 

going to look acceptable.  

 

To set the resolution, select Image, Image Size 

from the Menu Bar. Type in your resolution, 

then select Apply (pressing the Apply button is 

very important as pressing the Enter key will 

not activate your change).  

 

 Leave the Change Type drop-down box as Normal or it can take a long time to resize the image.  

 On the Legend Series: For wood, use 600 dpi. For acrylic and marble use 300 dpi.  

 On the Zing Series: For wood use 500 dpi, and 250 for acrylic and marble.  
 
 
 

 

Transform the Photo 

With the photo sized, and the resolution set, we are ready to transform the photo. 

From the Menu Bar select Transform, Photo Laser. Chose Automatic to transform photos using the settings you used 

last, or Interactive if you want to choose a different material or if you want to create custom settings.   
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Choosing Interactive allows you to choose between different materials. To choose a different material file, open the 

Materials Folder by clicking on the folder icon below the transformed photo. 

 

 

 

 

Select Your Material 

 

There is a long list of materials to choose from. Material names with 

“Epilog” in them incorporate the parameters we have found to create 

the best look for that material. There are Epilog material files for wood, 

glass, acrylic, leather, marble, and anodized aluminum. 

 

If you don’t see the Epilog settings they can be downloaded from 

www.epiloglaser.com/photolaserplus_instructions.htm. We also 

occasionally update or add to these files, so please visit our web site to 

keep pace with what’s new in the photo engraving world! 

 

 

 

http://www.epiloglaser.com/photolaserplus_instructions.htm
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Finish Transforming the Photo 

 

You can now preview the photo. There are a variety of tools the software makes available if you want to adjust our 

settings. These include histogram, edge, threshold, and more.  

 

 If you want to keep both the original 
and transformed photo onscreen, you 
can check Keep Original on this screen, 
otherwise it will be replaced with the 
transformed photo. 
 

 Press Okay and the window will close 
and take you back to your main page. 

 

 

 

 

 

 

 

 

Print to the Laser 

 

You’re now ready to print to the laser. 

Remember to print using the same resolution as 

your photograph. 

That completes the basic process of transforming 

a photo. Using the material settings created by 

Epilog, you can now easily produce stunning 

photos onto wood, acrylic and many other 

materials with a few clicks of your mouse! 
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Preparing a photo in Corel, transforming in PLP and then printing from Corel  

This section takes you through the steps needed to prepare a photo for a typical laser engraving project. Most photos 

are going to need to be sized, cropped, and have the resolution changed before they are imported into PLP (PhotoLaser 

Plus). We have found that most users find it is easier and more predictable to prepare the photograph using Corel 

Photo-Paint or similar software before importing it into PLP. Once the photo is imported into PLP, it can then be 

transformed for laser engraving. 

PLP, as well as other laser photo transforming software, can perform these functions, but none of them can perform 

them with the precision that even simple photo projects require.  Learning these steps will be helpful in quickly and 

easily preparing a photo for laser engraving.  

FOR EXEMPLIFYING THE
VISION AND ENTHUSIASM

OF OUR FOUNDER AND LEADER

JANUARY 22, 2012

Daniel Jackson

Pr esented to

ZACH MORTON MEMORIAL AWARD

        

For this project we will need to: 

1) Size the photo so it fits within the space provided 

2) Crop the photo 

3) Increase the resolution of the photo 

These three adjustments are pretty easy to perform. 

We first need to set up the plaque in CorelDraw. We’ve set up an 8” x 10” plaque size, added the text and drawn a box 

to represent the size and placement of the photo: 

  

Our example shows an 8” x 10” 

plaque that is typical of many photo 

engraving projects. The photo that 

was supplied for this project was a 

digital photo, 11” x 16” in size, with 

resolution of only 72 DPI. The 

customer also wanted the photo 

cropped.  

The box we’ve drawn shows that we have a 

3.5” x 3.5” space available for the photo. 

 



Page 12 of 24 
 

Size the Photograph 
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This illustration shows the imported photo 

next to our plaque. The photo is much larger 

than the 3.5” x 3.5” space we have available.  

We’ll duplicate the box and place it over the 

photo in approximately the area we want to 

crop. Then, we’ll shrink the photo using one 

of the corner sizing handles around the 

photo. 

The photo now fits in the 3.5’ x 3.5” space. 

We’re now ready to crop the photo. 
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Crop the Photograph 

There are several ways to crop a photo using CorelDraw, Corel Photo-Paint or PLP. Unfortunately, none of the standard 

methods of cropping allow you to easily and precisely crop to a specific area at a specified size, so we’re going to use a 

different method within Corel to get exactly what we want. We’re going to use the PowerClip/Place inside Container 

feature.  

To use this feature, first select the photo. Go to the Effects menu, PowerClip and then Place Inside Container. Then, click 

on the outline and your photo is cropped precisely to the size of your available space. 

  

Your photo is now the correct physical size. You may want to get rid of the outline, or you can leave it in place. If you 

leave it in place, it makes a nice border if it’s big enough. If it’s a vector outline (.001 or Hairline), it’s too small to 

engrave. 

 

Change the Resolution of the Photograph 

At this point we’re ready to change the resolution of the photo so that it matches the resolution we’re going to use for 

engraving – normally 500 DPI for the Zing and 600 DPI for all other Epilog lasers. There are numerous ways to change the 

resolution, but the following is the easiest for what we want to accomplish. Select the photo and go to Bitmaps/Convert  

to Bitmap. 
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The important part of this step of the procedure is that it changes the resolution of the photo to 600 DPI (500 DPI for the 

Zing lasers). Leaving the photo at its initial resolution would produce a very poor engraving. There are other methods of 

setting the resolution of the photo (such as the Resample function), but this is the most useful method for our project.  

 

Transfer the Photograph to PLP 

The photo is now cropped, set to the correct size, and is 

set to the proper resolution.  

Copy the photo from Corel, open PLP, and then Paste 

(Paste is under the Edit menu in PLP) the photo anywhere 

on the PLP page. 

  

 

 

 

 

 

 

 

 

 

 

 

 

Set Resolution to 500 DPI if you’re using a 

Zing and 600 DPI for all other Epilog lasers. 

These values are not in the drop down menu 

so you’ll need to type them in. 

Set Color mode to RGB Color (24-bit), or 

Grayscale (8-Bit). Either one will provide the 

correct image. 
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Transform the Photograph in PLP 

Select the photo and go to 

Transform/PhotoLaser/Interactive 

 

Choosing Interactive allows you to choose from a 

variety of different materials.  

To choose a new material, open the yellow Materials 

Folder by clicking on the folder icon below the 

transformed photo. 

 

 

 

 

 

 

 

 

 

Select Material 

There is a long list of materials to choose from. Material names with 

“Epilog” in them incorporate the parameters we have found to create the 

best look for that material. There are Epilog material files for wood, glass, 

acrylic, leather, marble, and anodized aluminum. 

 

If you don’t see the Epilog settings they can be downloaded from 

www.epiloglaser.com/photolaserplus_instructions.htm. We also 

occasionally update or add to these files, so please visit our web site to 

keep pace with what’s new in the photo engraving world!  

http://www.epiloglaser.com/photolaserplus_instructions.htm
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Finish Transforming 

You can now preview the photo. There are a variety of tools the software makes available if you want to adjust our 

settings. These include histogram, edge, threshold, and more.  

 If you want to keep both the original and 
transformed photo onscreen, you can check Keep 
Original on this screen, otherwise it will be replaced 
with the transformed photo. 
 

 Press Okay and the window will close and take you 
back to your main page. 

 

 

 

 

  

 

Copy and Paste, or Export Image to Corel 

You can Copy and Paste your transformed image to Corel (X4 or X5 only). You 

can also save the transformed image by using the Export Image function. 

Select the image and go to File/Export Image. Export the file as a .bmp. 

Make note of which folder you used to save the transformed file. You’ll need 

to access the file to import it into Corel.  

You can export both images or just the Transformed image. Many users 

delete the original and export just the Transformed image. 

 

 

The image on the right is the Transformed 

image that you will now export.   
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Import into Corel 

Use the Import command in Corel to bring your transformed photo into your Corel page. Place the transformed image 

into its designated spot and you are now ready to print! 

FOR EXEMPLIFYING THE
VISION AND ENTHUSIASM

OF OUR FOUNDER AND LEADER

JANUARY 22, 2012

Daniel Jackson
Presented to

ZACH MORTON MEMORIAL AWARD
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Creating a multiple badge layout with variable names using 

PhotoLaser Plus 

 

This document will show how to create multiple badges on a single page. We’ll show how to insert different names for 

each badge as well as how to include the same logo on all of the badges. 

This document will show a fairly simple creation and does not attempt to show all of the different options for badge 

layout. Future documents will discuss additional features of the badge layout feature. The easiest method of creating 

badges is shown here and illustrates many of the points that are necessary for more complicated setups. 

 

We want to start with a single badge -   

 

 

And use it to create a setup of as many 

badges as we want –  

 

 

 

We’re going to create 10 badges (nine with names and one blank). Each badge will be sized at 3” x 1”. 

 

Open PhotoLaser Plus.  

Let’s set the plate size to 3 x 1 – the size 

the size of a single badge.  
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The first step will be to Import your logo using File | Import.  

 

 

 

 

 
Next, we’ll create the space for the variable text we’re going to use 

for the badges. 

 

Go to the Text tool and select the Text Compose 

tool. This is the second  icon in the flyout. 

The other text tools will not allow you to auto condense 

long names. 

 
 
 
 
 

 

To use the Text Compose tool, click and drag a box within the 

badge. The box should be sized to accommodate your longest 

text string and located  where you want your text. Size and 

location are not critical at this point, so don’t worry about being 

overly precise here.  

 

It’s important that you click down and drag the text compose 

tool to draw a box for your text. Just clicking inside the badge 

invokes a different use for this tool and you will not be able to 

auto-condense your text strings. 

 

 

 

 

 

 

 

 

 

 

We’re now ready to type our variable, so let’s type the 

word Name.  

After typing the word you want to use as your variable 

you can move it to its proper location on the badge. 

We’ve moved our text to the right center 
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We’re now ready to create the badges. 

First, select everything on the badge. If 

you don’t select everything, the 

unselected objects will not be repeated 

on the badges. 

If you’ve moved your text it’s a good idea to make sure 

the text frame surrounding the text is still totally within 

the badge. 

 To view the text frame, either press Ctrl + E (this is the 

Edit text hot key), or double click on the text. You can 

see that our text frame is totally enclosed within the 

badge. 

Text frames that are not totally enclosed within the 

badge will not auto-condense within the badge. Text 

will spill outside the badge, which we do not want! 

Select the Badges icon in the tool bar (or 

in the menu bar select Layout | Badges) . 

The badge icon looks like this image. 
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4) Custom Size – The custom plate size corresponds 

to the size of your material you’re using to engrave 

the badges. We’re going to laser a 12” x 12” piece 

of plastic so we’ve set this parameter to 12 x 12. 

5) Compress text equally over copies – You do not need to check this box. Long names will be automatically 

compressed. 

 

 

 

 

 

 

 

6) Replaceable Items/text – The word “Name” is highlighted in this box. The word “Name” corresponds to the 

word “Name” that you typed into the text frame earlier in this procedure. Whatever word you type into the 

text frame can be used as a variable. It’s vitally important that the variable be highlighted before moving to 

the next step. 

7) Replacement Data File – If this box is checked you can Browse for a data file that has the names already 

typed. Your customer may have sent you a Tab delimited text file with all of the names, or your customer 

may have used one of the other standard text formats that are commonly used for this type of application. 

You can see that we are using a Notepad file to save the names that we’re going to engrave. 

8) OK - After highlighting the variable word (in our example, “Name”), you will click on OK. If you do not have 

a saved text file you want to access for your names you will want to uncheck the Replacement Data File box 

(icon # 7). The Text Substitution data window will pop up. Use this data window to type in the names you 

are going to engrave. The Text Substitution box is shown below. We have already populated the box with 

the names we want to use. 

Set the Badge Setup parameters just as shown in the 

image at the right. Some of these settings are 

optional, but most are required. Once you have a 

chance to run a few badge files you can start 

experimenting with each parameter: 

1) Number of Copies – this usually defaults to 

the last number you used. We’ve set it to 10. 

The number you insert in this box will 

correspond to the number of boxes shown in 

the visual graphic layout of the badges (icon 

# 9). 

2) Score Lines – This is an optional setting that 

you can use to vector cut out the badges if 

you’re using a material like plastic. 

3) Use Plate – It’s important that this be 

checked so that the graphic corresponds 

with the actual plate size you’re using.  

6) Replaceable Items/text – The word “Name” is highlighted in this box. The word “Name” corresponds to the 

word “Name” that you typed into the text frame earlier in this procedure. Whatever word you type into the 

text frame can be used as a variable. It’s vitally important that the variable be highlighted before 

moving to the next step. 

7) Replacement Data File – If this box is checked you can Browse for a data file that has the names already typed. 

Your customer may have sent you a Tab delimited text file with all of the names, or your customer may have 

used one of the other standard text formats that are commonly used for this type of application. You can see 

that we are using a Notepad file to save the names that we’re going to engrave. 

8) OK - After highlighting the variable word (in our example, “Name”), you will click on OK. If you do not have a 

saved text file you want to access for your names you will want to uncheck the Replacement Data File box (icon 

# 7). The Text Substitution data window will pop up showing either the names in your saved file or a blank box 

for you to type in names if you did not select a file.  

9) Graphic showing layout of the badges. 

 

 

  1 
  2  3 

 4 

 5 

 6 

 9 
 8 

 7 
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After clicking the OK button you will be taken back your drawing page and the badges will all be properly laid out and 

populated. You can see that we have 10 badges. One of them was left blank intentionally just to show what would 

happen if you had more badges than names (we only had 9 names, but had put the number 10 in the Number of copies 

box (icon #1 of the Badge Setup window). 

 

 

 

 

 

 

 

That’s it! You are now ready to print all of your badges in one setup to a 12” x 12” page.  

 

 

 

Summary and quick reference guide 

1) Create a plate that matches the size of the badge you are going to engrave 

2) Import your logo or other data that will be common to all badges 

3) Select the Text Compose tool from the text toolbox 

4) Draw your text compose box  

5) Type in the word that you will use as your variable – we used the word “Name” 

6) Select all objects on the badge 

7) Click on the Badge Setup icon 

8) Set the Badge Setup page as described in detail in this procedure 

1) Number of badges 

Click OK in the Text Substitution box after 

you have typed the names and verified they 

are correct. 
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2) Score lines – if desired 

3) Check “Use Plate” 

4) Set “Custom Size” to match your engraving material size 

5) Check “Compress text equally over copies” to compress all names to match the longest text string 

6) Check “Use Compression of original copy” to compress only the longest text string(s)  

7) Highlight your variable word – VERY IMPORTANT! 

8) Check “Replacement Data File” to access a saved file. Leave unchecked to type the names in manually 

9) Click OK 

9) Print! 

 

 

 

Troubleshooting 

 

 

Problem: The logo doesn't appear on the badges. 

 

Solution: In step 6, you did not select everything 

on the badge before clicking the Badge Tool. 

 

 

 

 

 

 

Problem: The word “Name” is repeated on all 

badges. 

Solution: In the badge setup parameters (see the 

circled  icon #6) you did not highlight "Name" as the 

field to replace. 
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PhotoLaser Plus Installation Help 

These instructions provide solutions to installation problems when trying to operate PhotoLaser Plus (PLP). Our 

experience shows that installation problems can produce one of three error messages: 

1) Cannot install Product.ini 

2) This is a demo version and can only be used to produce 10 cuts 

3) Cannot find security key 

We have found that the solution to all three error codes is to insure there are license files in the C:/EngraveLab 

PhotoLaser Plus file folder. 

You must activate PLP before it can be used. The activation process is supposed to place two license files into the 

C:/EngraveLab PhotoLaser Plus file folder. If you receive an error message, the license files are either not there, or 

cannot be recognized. 

We have found that the license files are key to operating the software and must be in the correct folder for everything 

to work. 

Placing the license files into the correct location is an easy process. If you have an error when trying to run PhotoLaser 

Plus after you have activated it, you must retrieve new license files from CadLink. The easiest way to do this is to access 

the registration acknowledgement email that was sent by CadLink when you registered. The email looks like this: 

  

 

You must unzip or extract the license files to use them. Use WinZip to unzip the files. If you do not have WinZip, right 

click on the license file you downloaded from CadLink. One of the options when you right click is Extract. Click on this  

option and extract the files to a location you can find them. 

 

Once you have unzipped or extracted the license files, copy and paste them into the C:/EngraveLab PhotoLaser Plus file 

folder. You do not need to open the license files. Simply copy them into the folder. If you receive a message stating that 

the files already exist, copy over, or replace the old ones with the new files. 

This simple process has resolved all of the issues we have seen to date.  

 

This email provides two different links 

that can be accessed to download the 

license files. Follow either link and 

download the Zip file holding the 

license files. If you use the 2nd link, 

you will be asked for your license 

code. This is the six digit code 

included in the email (Illustrated in 

the red box). It is not the 10 digit 

activation code that was included 

with your copy of the software. 

 


